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Abstract of Dissertation Presented to the Graduate School
of the University of Florida in Partial Fulfillment of the
Requirements for the Degree of Doctor of Philosophy

TITLE OF THE WORK, CENTERED, SINGLE-SPACED,
IN ALL CAPITAL LETTERS, EXACTLY AS ON TITLE PAGE

By
Your Name as on the Title Page, but in Title Case
Month and year of graduation
Chair: Name (Do not put Dr. before the name, and do not put degrees after it)
Cochair: Name (if any, otherwise delete this line)
Major: See your Editorial Document Management record for your exact major

Lorem ipsum dolor sit amet, consectetuer adipiscing elit. Integer non odio eget
ipsum placerat tincidunt. Sed euismod, elit quis egestas euismod, massa est placerat
purus, posuere mattis arcu massa ut dui. Sed vitae turpis non diam malesuada dapibus.
Sed dapibus mi non ligula. Aliguam erat volutpat. Ut eu elit. Nam enim. Ut bibendum
eros ut erat. Nullam elit. Nulla rutrum urna hendrerit odio. Vivamus volutpat. Aliquam
erat volutpat. Nulla vulputate nisl ut guam. Nunc et nunc sed ante mattis convallis. Nam
nibh mauris, adipiscing eu, tristique sit amet, egestas id, dui. Integer odio.

Vestibulum vel enim. Mauris consequat. Nulla facilisi. Ut bibendum lectus. Nulla
pede est, placerat non, pulvinar et, ornare in, leo. Etiam ultrices ullamcorper diam.
Curabitur et enim. Mauris nulla. Etiam malesuada adipiscing sapien. Maecenas nisi.
Mauris id odio a nibh fringilla sodales. Suspendisse lobortis diam eget magna. Ut
pellentesque rutrum sem. Nullam facilisis sem non metus. In hac habitasse platea

dictumst. Quisque facilisis tempor diam. Sed sed lorem et purus dictum dapibus.

Pellentesque euismod ligula et lectus facilisis varius.
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Maecenas feugiat facilisis nisi. Etiam varius sagittis nunc. Morbi porttitor metus
vitae massa. In ac nulla at elit venenatis bibendum. Aliquam mattis sapien tincidunt
metus. Donec ultrices risus at massa. Sed velit tortor, vestibulum nec, tincidunt aliquam,
adipiscing ut, sem. Nam sed ante aliquet erat dapibus accumsan. Pellentesque sed
orci. Suspendisse egestas velit. Curabitur purus magna, interdum non, pharetra eu,
dictum at, ligula. Mauris pede dolor, placerat non, semper a, accumsan eget, sem. Duis

placerat neque non leo. Fusce massa.
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CHAPTER 1
CHAPTER TITLE GOES HERE

First-Level Subheading

The first-level subheading uses the formatting style 02 First-Level Subheading
(BOLD). It centers, single line spaces and advances the text after it by one line. No
extra carriage returns are needed to correctly space the text that follows. First-level
subheadings should be in title case (capitalize the first letter of major words). You must
capitalize the first-level subheadings yourself. MS Word can simulate Title Case
capitalization but it will capitalize the first letter of EVERY word including articles and
prepositions. First-level subheadings must not have more than a single blank line space
before or after the heading.

Another First-Level Subheading

The heading above shows that if you have a subheading of a certain level, you
must have more than one. The rationale is that you cannot have a list of only one item.

Second-Level Subheading

The second-level subheading uses the formatting style 03 Second-Level
Subheading (BOLD). It will "flush-left," boldface and single space the text, and
advances the text after it by one line. Second level subheadings are also in Title Case
(The first letters of principal words must be capitalized).

Another Second-Level Subheading

The heading above shows that if you have a subheading of a certain level, you

must have more than one. The rationale is that you cannot have a list of only one item.
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Third-level subheading

The third-level subheading uses the formatting style, 04 Third-Level Subheading
(BOLD). It will "flush-left," boldface and single space the text, and advances the text
after it by one line. For the third-level subheading, only the first letter of the first word
and proper nouns are capitalized (Sentence case). Third-level subheadings must not
have more than one single-spaced blank line before or after the heading.

Another third-level subheading

The heading above shows that if you have a subheading of a certain level, you
must have more than one. The rationale is that you cannot have a list of only one item.

Paragraph heading. First line of text follows the period on the same line as the
heading. Paragraph headings are indented, boldfaced, and followed by periods or
colons; only the first letter of the first word and proper nouns are capitalized. Paragraph
headings do not have their own “style” and are not listed in the table of contents. (This
paragraph uses 05 Body Text style.) Paragraph headings can also be used in bulleted
lists.

Another paragraph heading. Here are a few special points to keep in mind when
reviewing your thesis or dissertation:

Heading levels must be used in the order listed above (the only exception

would be if you use only three levels throughout and you elect to use

paragraph-style headings instead of third-level headings). Levels must be

ordered consistently from chapter to chapter. (This paragraph uses the 07
Block Text—Block Quote style)

When you exit the Block Quote style you often continue the previous paragraph rather

than starting a new one. In that case you would apply 06 Body Text No Indent.
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Section Order

In accordance with the above requirements, all manuscripts must contain the
following components, in the order listed (The list uses 08 Bulleted List—Short because
no item on the list is longer than one line):

Title page

Copyright page

Dedication (optional)

Acknowledgments (optional)

Table of Contents

List of Figures (if necessary)

List of Tables (if necessary)

List of Symbols/Abbreviations/Nomenclature/Acronyms (if necessary)
Abstract

Body chapters (number and titles will vary according to manuscript organization)
Appendix (optional)

List of References

Biographical Sketch

Margins, Typeface, Size (Font) and Text Spacing

Margins are 1"for all pages (top, bottom, left, and right). Use 12-point Arial
(throughout, including tables and figures). Double-space most text. Indent first lines of
paragraphs consistently. Single-space headings, tables, figures, bulleted-list items
(“Short” list is no item longer than one line. “Long” list is if any item is longer than one
line), equations, block quotes, and appendix matter (with only one blank line space
before and after the single-spaced matter). No more than one blank line space
anywhere

Page Numbers
Arabic numerals (1, 2, 3, etc.) starting with the title page, all pages are numbered,

centered at the bottom of each page
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CHAPTER 2
USING THE FORMATTING TEMPLATE

What Is a Style?

Styles define the appearance of various text elements in your document, such as
headings, captions, and body text. When you apply a style to a paragraph or word, you
can apply a whole group of character or paragraph formats or both in one simple
operation. When you want to change the formatting of all the text of a particular element
at once, you just change the style that's applied to that element. Styles make formatting
your document easier. Additionally, they serve as building blocks for outlines and tables
of contents.

The Application Support Center provides a group of general purpose styles to help
you format your document and give your thesis or dissertation a continuity of
appearance. Styles cannot do everything but they can be used for general formatting
purposes. Each style created by the ASC is listed in Table 2-1.

How Do You Apply a Style?

The styles used in this document are called paragraph styles. Paragraph styles
are used to format the entire text within a paragraph. To apply a style, follow these
instructions:

. Select the text you want to format

. Click the Format menu and then the Styles and Formatting option. This will open
the formatting menu to the right of your document.

. Click the style desired in the Styles list. The text is now formatted by the
specifications of the style. If, at any time, the text should appear wrong, simply
reapply the style.

An alternative way of selecting the style is to use the Formatting toolbar:

. Place the cursor within the text you want to format
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. Click the Down-Arrow next to the Style field on the Format toolbar and select a
Style from the drop-down list.

. If the Formatting toolbar is not present, click the View menu and then the Toolbars

option. In the Toolbars list, check Formatting. The Formatting toolbar should then
appear at the top of your screen.

Why Use Our Styles?

If you use the preprogrammed styles we provide, your Table of Contents, List of
Tables, and List of Figures will generate with a click of the mouse, and the textual items
they reference will have the proper formatting. As an added benefit, your Table of
Contents will automatically link to the chapter titles and subheadings when using the
Adobe PDFMaker plug-in for Microsoft Office.

The following captions are examples of the use of “objects.” Object are any
addition to the thesis or dissertation that does not fit the category of table or figure.
Sounds and movies are the most common types of objects. The type (extension) and
size of an object file should be included at the end of the caption but this information is

not needed in the list of objects.

Object 2-1. Sample sound file of Stewie Griffin saying “Victory is Mine!” (.wav file 9KB)

Object 2-1. The readme.doc file as a PDF document (.pdf file 34 KB)

In the final pdf these captions would be linked to the actual documents and would open
them when clicked. These links would have to be created after the pdf is made and the
files would have to be uploaded as support files during the final submission process. (In

the interest if simplicity these files are not included in the single file template).
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Table 2-1. Partial list of files contained in the Template 80 folder

File name This file contains

Title Title page

Copy Copyright page

Dedicate Dedication page

Acknowledgment Acknowledgment page

Contents Table of contents page

Tables List of tables page

Figures List of figures page

Objects List of objects page

Abstract Abstract page

Abstract-General The sample document for the General Audience Abstract
Chapterl Chapter 1

Chapter2 Chapter 2

Chapter3 Chapter 3

Chapter4 Chapter 4

Chapter5 Chapter 5

Chapter6 Chapter 6

Chapter7 Chapter 7

Chapter 8 Chapter 8 (additional chapter)

Chapter 9 Chapter 9 (additional chapter)

Appendix-a Appendix A

Appendix-b Appendix B

Appendix-c Appendix C (additional appendix)
Appendix-d Appendix D (additional appendix)
Appendix-e Appendix E (additional appendix)

Appendix-f Appendix F (additional appendix)

Master The master document (used for final printing)
ReadMe The read me file containing instructions and helpful hints
Ref Reference pages

Bio Biographical sketch

Style-Archive Archive of formatting styles in case you need them.

This is the first example of a table. The cells of the table use the Normal style. The caption of
the table uses the 11 Caption Table style. Tables should be followed by one blank line using the
Normal style.
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CHAPTER 3
CREATING AND UPDATING THE TABLE OF CONTENTS, LIST OF TABLES, AND
LIST OF FIGURES

The Table of Contents and List of Tables/Figures was created by using the Index
and Tables tool found in the Insert menu. The Table of Contents is designed to collect
all text using the heading styles for section titles, chapter titles, and subheadings
automatically on demand. The List of Tables is designed to collect all text using the 11
Caption Table style. The List of Figures is designed to automatically collect all text using
the 10 Caption Figure style. Tables of contents and lists of tables/figures can be
designed to gather text based on field codes. However, we do not discuss that option in
our dissertation. If you do not use our styles for creating tables of contents or lists you
will need to investigate creating your own table of contents and lists. See our tutorial on
updating the Table of Contents, List of Figures, and List of Tables. They can be found
here:

http://etd.helpdesk.ufl.edu/present/updating-toc.html

http://etd.helpdesk.ufl.edu/present/updating-lot-lof-loo.html
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Table 3-1. List of sections contained in the template

Section name

This section contains

Title Title page

Copy Copyright page

Dedicate Dedication page
Acknowledgment Acknowledgment page
Contents Table of contents page
Tables List of tables page
Figures List of figures page
Objects List of objects page
Symbols List of Symbols/Terms/Abbreviations
Abstract Abstract page

Chapterl Chapter 1

Chapter2 Chapter 2

Chapter3 Chapter 3

Chapter4 Chapter 4

Chapter5 Chapter 5

Chapter6 Chapter 6

Chapter7 Chapter 7

Appendix-a Copyright permission sample letter
Appendix-b Appendix B

Appendix ¢ Landscape page example
Ref Reference pages

Bio Biographical sketch

This is an example of a table. The cells of the table use the Normal Text style. The
caption of the table uses the 11 Caption Table style. Tables should be followed by one
blank line using the Normal style. Table formatting is discussed in detail in chapter 2.
Notes following a table should be in paragraph style and may be formatted in 10 pt type
to conserve space.
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Figure 3-1. Century Tower taken in 1999 from Jim Albury’s office window
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UNIVERSITY OF
QFLDRIDA

C - i ' @ D

Figure 3-2. Series of University of Florida landmarks. A) taken from the base of Century
Tower looking upward at 3:00 PM, B) taken from the northwest corner of the
Music Building, C) taken from the CSE atrium at 9:00 PM and D) the
University Auditorium. (Note: the caption in the list of figures does not include
the sub-part descriptions).

A

Figure 3-3. Example of a figure with sub-parts. A) Eating one battery. B) Eating five
batteries. When writing your thesis or dissertation becomes a stressful ordeal,
sometimes humor can help lighten the mood. Please do not try this at home.
(Source: http://www.homestarrunner.com/sbemail64.html. Last accessed
December, 2003).

22


http://www.homestarrunner.com/sbemail64.html�

Why use our styles?
If o use the styles we provide, your TABLE OF
CONTENTH ca.n_he getiet ated a};tnmaticallj.r with TABLE OF CONTENTS
the correct text with the appropriate page mambers.
page
CHAFTER 3 LIETOFFIGURES e I
MATERIALS AND METHCODS LETOFTABLES e W
This is 4 condersed repmsentation of Chapter ABRSTEACT e WL
showing how all of its headmg styles areused. CHAPTEERS
ifermation m the areawill contirme to page 34,
IINTRODTIC TS oL
The paragraphs in this section for the most part
wse fhe Bady Tevtste; however, the stles Body Tent ZREVIEW OF LITERATURE ...l 1S
No Indeng Block Text, Nevana] and Capfioms shoald be Histoaical Cvervier .. 1B
sed where appeortate. H Coptenporary C]J::sel].r Relaied Sb.ldles 1
Sanple Characteristics———— | | SMATERIATS AMD METHODS . 28
The fisst level subheadivg shove wonld normally Saﬁg‘@l‘; iﬂhi‘&ﬁ;ﬁj“s “"'ﬁ
appear on page 3. This subheadivg is a section of | ¥ anu]LalI'Lsh:urg.r am
Baterials and Methods and contains o secom | Vetodo I
subhead ings. sm:m AND DIECTSSION LT
Ageand Gender Results of the Stady.... .0
The second-level sbheading, Aze Mot That the Second Line of a Hea:hrg That Bms
appears onpage 40 and is a subsect More Than Cme Line Is Inderted ... B4

Charartenstios. The mmftemath
comtirue to page 42,

Familial Hiz

What are Styles?
We ugsed the following stiesto create this

exathple:
The secord-level aubheadmgs F: 15tory appear )
on paze 48 and is a ah section of 5 Chataeteristins . | 01 CHAPTER TITLE ............. Title of Chapter
The ifonmation in the sectionwill géntime topage 35. 02 First Lewvel Subheading  First-level
Metho dologgy Subheading
) ) ) 03 SBecond Level Bubheading 2 econd-lewvel
Methodokbzy 1s the second secton of Materials and Sbheadin
Metheds and contains no stbheading. The inframation atang
in the sectionwil comtime to page &6. 05 Body Text........ Standard Paragraphs

Figure 3-4. How styles appear in the table of contents. By applying the preprogrammed
formatting styles to your chapter titles and subheadings, they will be updated
to the table of contents with the appropriate page number with just a click of
the mouse.
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Whv use our styles?

If o use the styles we provide, your TABLE
OF CONTENTS can be generated automati cally
with the correct text with the appropriate page

nunhers.

CHAFPTEE
M4 TERIALS AHD

hnar allof its headihg soples
the ares wrill cordine to page

or page 34, This sabheading
Dlethods and cortaine baro sac

Figure 3-5. How styles are used to format your text. By applying the preprogrammed

TAELE OF COHTEHNTS
Rags
ACEHOWLED GMEH TS e ii
LISTOFFIGUEES . e o
LISTOF TAELES .. e
AEITERIT e i
CHAPTER
1 MTRODTCTION .. 1
2 EEVIEW OF LITEEATURE ..., 13
Historical Dmemrier. ..o e, 16
Conternporary Closelr Felated Smdies ... 20
3 MATERIALS AND METHOD S ... 28
Sanple ChaTacteTistics e, 34
Byge and Cerder 40
Familia THISEODE oo 48
Bt hod 0doE e e O
4 FESUL TS AHD DISCTIESION .. BT
Eemlts of the S0ady ... e, Ta
Mote Thatthe Second Line of a Heading That Fane
More Than One Line I Indented ... a4
5 SUMMARY 4HD CONCLTUSIONS. e, o9
APPEND I
A IFY¥O0T HAVE OHLY OHE APPENDLL, DOM'T
COLL IT " e 105
E SUPERFLUOUSMATERIAL......vvvvneenen.. 109

What are Styles?
Weused the following styles to create
this example:

\IEI CHAPTER NUMEER ........# of Chapter
\Gl CHAPTER TITLE............ Title of Chapter
\32 First-Level Subheading ...

1 st-lewvel Suh.
3 BecondLevel Subheading ... 2nd-lewel Sub.

05 B ody Text ... 3tandard Paragraphs

formatting styles to your chapter titles and subheadings, they will be
automatically formatted such that their spacing and justification are in
compliance with the Editorial Office guidelines.
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CHAPTER 4
ARTICLES AS PART OF THESIS OR DISSERTATION

Candidates in scientific fields often plan to publish results of their research as
journal articles. A chapter of the thesis or dissertation may later become a journal
article, for example. Perhaps the thesis or dissertation contains several such chapters.
In such cases, the thesis or dissertation must be organized as a unified whole. The
thesis or dissertation is your primary objective and publication is your secondary
objective. Use the Graduate School’s formatting requirements for spacing and margins,
pagination and copy sequence, heading formats, and overall preparation.

The Graduate School encourages candidates to use the scholarly journal in which
they have published, or hope to publish, as a guide for thesis and dissertation
preparation. A printed journal article on an analogous subject serves as a tangible,
graphic guide for style of writing, use of abbreviations and numbers, reference system,
and overall usage policies that help the candidate become proficient in the editorial
requirements of the journal. The printed article shows specific usage. Do not use the
journal style manual to format your thesis or dissertation only to prepare the article later
for publication in that journal.

Acceptable Usage

If each chapter is complete within itself and treats one of several aspects included
in the entire study, a general introductory chapter must be added as the first chapter of
the thesis or dissertation. A final chapter must be added that discusses results,
conclusions, or further research for the entire study. Required for all University of
Florida theses and dissertations:

o A common Table of Contents covering the entire study.

25



. A common Abstract for the entire study (in the preliminary pages, before
Chapter 1)

o A common Reference List (however named) for the entire study
o All pages numbered in sequence—from Page 1 through the Biographical Sketch.
Unacceptable Usage
The following practices are not acceptable for University of Florida theses and

dissertations:

. Omission of material that unites components to form a complete manuscript (for
example, omission of the general introductory chapter or the conclusion chapter).

. Reference list (however named) at the end of each chapter.

. All-cap subheadings used by journals for rapid content identification on double
column pages.

o Beginning first-level subheadings on separate pages.
. Use of an abstract at the beginning of each chapter.

. Chapters paged individually, with 1 appearing on the first page of each new
chapter.

. Use of double-spaced references and any other use obviously based on journal
styles not suitable for a unified thesis or dissertation presentation. For example,
tables and figures cannot be grouped at the end of the thesis or dissertation. They
must be inserted near the text where they are first mentioned; or grouped logically
at the end of that chapter.

. Inclusion of coauthored articles, except those portions and materials contributed
by the student. Material produced by coauthors should be so noted and cited
appropriately. It is the supervisory committee’s responsibility to ensure that the
thesis or dissertation reflects a sufficient level of original and scholarly work by the
candidate.
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CHAPTER 5
ELECTRONIC THESIS OR DISSERTATION (ETD)

Format

All manuscripts must be submitted on plain paper in a single compartment
expanding wallet document envelope for first submission, and as a single PDF for final
approval. Students who do not have access to the correct version of the Adobe
software, need assistance in creating their PDF, links and bookmarks, or need help
linking media files within the PDF may contact the Application Support Center at (352)
392-4357 to set up an appointment. In some cases, distance students may email their
document to ASC for PDF conversion; please contact them (etd@grove.ufl.edu) for
more information.

The thesis file or files should be converted to PDF after the paper copy has been
edited by the supervisory committee and the Graduate School Editorial Office and all
corrections and changes have been made. The formatting requirements for the PDF are
nearly the same as for the paper copy (for example, fonts, indents, heading levels and
capitalization, margins, and page numbering). However, listed below are formatting
requirements that apply only to ETDs.

Files and Links or Bookmarks

If the thesis consists of more than one file, all files should be named to one
directory before adding the links. This avoids changing file names and causing broken
links in the ETD submission. All links/bookmarks must be highlighted in blue. They
should not be underlined. The working condition of all links should be checked before
submitting the PDF. The PDF file(s) and other files should be checked carefully before

submitting them.
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Table of Contents

The table of contents should be formatted the same as for paper final submission.
However, you must link all major division headings (acknowledgments, list of tables, list
of figures, abstract, chapter and appendix titles, reference list, and biographical sketch);
and any subheadings to the appropriate pages in the text. Use blue to highlight all links
in the table of contents.

Lists of Tables, Figures, Objects

These lists are particularly helpful to the ETD reader. Objects are only found in
ETDs. Objects are defined for this purpose as video, audio, or other items that are not
distinctly tables or figures. The entries in these lists should each be linked to the actual
corresponding figure, table, or object in the text. Use blue to highlight all links in these
lists.

Figures, Tables, Objects in the Text

For certain figures, maps, tables, and so, it may be desirable to link to a separate
file, for example, for larger size or higher resolution. If this is done, there must still be a
version of the figure or table incorporated in the text as with the paper copy of the
thesis. The figure legend below the figure or a note below the table should then link to
the separate file. With multimedia objects that cannot be represented graphically in the
PDF, a complete title/description that links to open the file should be included in the text.
All of these links should be in blue and must contain a parenthetical notation about the
file type and size.

Figures, tables, and objects that are not embedded in the document should always
be described fully in the text. As technology changes and is upgraded, there is a chance

that these illustrations will not migrate with the thesis.
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File Name

The file name for the ETD should be your surname linked to your first initial by an

underscore blank and followed by .pdf. That is, Surname_I.pdf.
Copyright

Because the PDF is archived and is made available on the Web, written
permission is needed for use and electronic publication of copyrighted text, figures,
tables, and objects. Also, because the PDF is archived and available on the Web, it is
wise to include a copyright page in all ETDs. The copyright page should be immediately
after the title page. The copyright page format is shown in Appendix F of this guide. It is
not necessary to register copyright with the U.S. Copyright Office.

Submitting the ETD

See http://etd.circa.ufl.edu and choose “Submit Your PDF” for instructions.
Electronic submission is only for final submission, after editorial review and after all
corrections have been made. Create your PDF and log into
https://apps.rgp.ufl.edu/edm_app/etd_login.cfm to submit the PDF. Check the box
“Submit to Editorial Office for Review.”

Acceptable ETD Formats

The Florida Center for Library Automation specifies which formats are currently
permissible for electronic submission. The next table, “Acceptable ETD Formats.”
shows levels of acceptability for various ETD media. No effort will be made to migrate

forward those ETDs that are in the “Not accepted” category.
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Table 6-1. Acceptable ETD formats

Media

Preferred

Acceptable

Digital archaeology  \ ¢ 5ccepted

only
Text PDF TML WPD
XML XHTML
TXT DOC
RTF
SMGL
Still image TIFF PNG IPX GIF
JPG SID
DJVU
Audio WAV
MP3
Audio/video MPEG AVI RM
?MOV
Multimedia ?Flash
?Macromedia
Director
?PPT
?WebCT
WMV
Database/ MDB
spreadsheet XLS
MySQL
Computer TXT EXE
programs (source code) CFM
ASP

30



CHAPTER 6
HOW TO COPY AND PASTE INFORMATION FROM OTHER FILES

Styles

Every MS Word document uses styles to format information. To help prevent the
unnecessary copying of different styles into your dissertation, follow these rules of
thumb when copying information:

If you are pasting text into a dissertation document, use the Paste Special option
and the Unformatted text option. Then apply the styles of the sample dissertation to
reformat the text. Be aware though that this will remove any italics, boldfacing or special
characters you are using.

. When you cut, make sure you do not remove the section break at the end of the
chapter or file.

. If you are pasting graphics and tables, then use the normal Paste option.

. Never overwrite a style with a new definition unless you are sure of the
repercussions.

. Never redefine a style with a new definition unless you are sure of the
repercussions.

o You can always reapply a style.
Landscape Page Template

The next page is a landscape page template. Copy the section break following this
paragraph through the first line of text (just to be sure) after the next section break. Go
to the page after where you want the landscape page to appear. Choose “View” >
“Header and Footer” and If the words “same as previous” appear by the header and/or
footer box, turn this feature off. Go to the page before the landscape page, click at the

end of the last line and then paste. You should get a correctly formatted landscape page
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with the number on the left side in the same relative position the page number would be,

in a portrait page..
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This is a landscaped page. No paragraph text should appear on a landscape (also known as “broadside”) page. Only
the Figure or Table Caption should be on this page along with the table or figure itself. Page numbers no longer must be

placed on the side of a landscape page!
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CHAPTER 7
ANOTHER CHAPTER TITLE

Subheading

Body Text goes here. If you need more chapters copy and paste this “chapter” as
many times as needed.

Another Subheading

Always end a chapter with a section break — next page so footnotes will re-start

their numbering.
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APPENDIX A
TITLE OF APPENDIX A

An Appendix is simply another chapter of some “extra stuff.” Some of the
formatting requirements are relaxed so that some documents may be presented in their
original format. However, the margin requirements remain in effect throughout the entire
document regardless of the original document’s margins. Lorem ipsum dolor sit amet,
consectetuer adipiscing elit. Integer non odio eget ipsum placerat tincidunt. Sed
euismod, elit quis egestas euismod, massa est placerat purus, posuere mattis arcu
massa ut dui. Sed vitae turpis non diam malesuada dapibus. Sed dapibus mi non ligula.
Aliquam erat volutpat. Ut eu elit. Nam enim. Ut bibendum eros ut erat. Nullam elit. Nulla
rutrum urna hendrerit odio. Vivamus volutpat. Aliquam erat volutpat. Nulla vulputate nisl
ut quam. Nunc et nunc sed ante mattis convallis. Nam nibh mauris, adipiscing eu,
tristique sit amet, egestas id, dui. Integer odio.

Vestibulum vel enim. Mauris consequat. Nulla facilisi. Ut bibendum lectus. Nulla
pede est, placerat non, pulvinar et, ornare in, leo. Etiam ultrices ullamcorper diam.
Curabitur et enim. Mauris nulla. Etiam malesuada adipiscing sapien. Maecenas nisi.
Mauris id odio a nibh fringilla sodales. Suspendisse lobortis diam eget magna. Ut
pellentesque rutrum sem. Nullam facilisis sem non metus. In hac habitasse platea
dictumst. Quisque facilisis tempor diam. Sed sed lorem et purus dictum dapibus.
Pellentesque euismod ligula et lectus facilisis varius.

Maecenas feugiat facilisis nisi. Etiam varius sagittis nunc. Morbi porttitor metus
vitae massa. In ac nulla at elit venenatis bibendum. Aliguam mattis sapien tincidunt
metus. Donec ultrices risus at massa. Sed velit tortor, vestibulum nec, tincidunt aliquam,

adipiscing ut, sem. Nam sed ante aliquet erat dapibus accumsan. Pellentesque sed

35



orci. Suspendisse egestas velit. Curabitur purus magna, interdum non, pharetra eu,
dictum at, ligula. Mauris pede dolor, placerat non, semper a, accumsan eget, sem. Duis
placerat neque non leo. Fusce massa.

Duis sit amet dui id diam venenatis vulputate. Praesent malesuada turpis a velit.
Donec leo sem, auctor vitae, dictum sed, vulputate et, libero. Phasellus a risus. Proin ut
ante in felis imperdiet molestie. Pellentesque consequat ultricies felis. Nulla scelerisque
condimentum sapien. Phasellus iaculis luctus mi. Suspendisse facilisis. Suspendisse in
libero. In auctor nunc quis tortor. Nam suscipit nulla et lorem. Ut purus ligula, vehicula
eget, malesuada ac, vestibulum eu, enim.

. Donec consequat justo a orci commodo pharetra.

) Vestibulum ante ipsum primis in faucibus orci luctus et ultrices posuere cubilia
Curae; Nullam condimentum arcu in turpis.

o Nam justo sem, congue ut, egestas nec, tempor sed, turpis. Proin justo arcu,

hendrerit posuere, auctor eget, pharetra a, tellus. Nulla sagittis. Nulla quis mi at
turpis ultricies adipiscing. Quisque venenatis. Sed ut libero.

Etiam lectus orci, luctus ut, tempor non, adipiscing a, libero. Fusce turpis ipsum,
ultricies nec, varius ac, pretium vel, pede. Sed turpis massa, aliquet nec, adipiscing sed,
viverra eu, arcu. Pellentesque commodo iaculis leo. Vivamus nunc nibh, tempus sit
amet, molestie vitae, euismod quis, lacus. Phasellus vitae justo ac nulla vestibulum

rhoncus.
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APPENDIX B
TITLE OF APPENDIX B

Lorem ipsum dolor sit amet, consectetuer adipiscing elit. Integer non odio eget
ipsum placerat tincidunt. Sed euismod, elit quis egestas euismod, massa est placerat
purus, posuere mattis arcu massa ut dui. Sed vitae turpis non diam malesuada dapibus.
Sed dapibus mi non ligula. Aliquam erat volutpat. Ut eu elit. Nam enim. Ut bibendum
eros ut erat. Nullam elit. Nulla rutrum urna hendrerit odio. Vivamus volutpat. Aliquam
erat volutpat. Nulla vulputate nisl ut quam. Nunc et nunc sed ante mattis convallis. Nam
nibh mauris, adipiscing eu, tristique sit amet, egestas id, dui. Integer odio.

Vestibulum vel enim. Mauris consequat. Nulla facilisi. Ut bibendum lectus. Nulla
pede est, placerat non, pulvinar et, ornare in, leo. Etiam ultrices ullamcorper diam.
Curabitur et enim. Mauris nulla. Etiam malesuada adipiscing sapien. Maecenas nisi.
Mauris id odio a nibh fringilla sodales. Suspendisse lobortis diam eget magna. Ut
pellentesque rutrum sem. Nullam facilisis sem non metus. In hac habitasse platea
dictumst. Quisque facilisis tempor diam. Sed sed lorem et purus dictum dapibus.
Pellentesque euismod ligula et lectus facilisis varius.

Maecenas feugiat facilisis nisi. Etiam varius sagittis nunc. Morbi porttitor metus
vitae massa. In ac nulla at elit venenatis bibendum. Aliguam mattis sapien tincidunt
metus. Donec ultrices risus at massa. Sed velit tortor, vestibulum nec, tincidunt aliquam,
adipiscing ut, sem. Nam sed ante aliquet erat dapibus accumsan. Pellentesque sed
orci. Suspendisse egestas velit. Curabitur purus magna, interdum non, pharetra eu,
dictum at, ligula. Mauris pede dolor, placerat non, semper a, accumsan eget, sem. Duis

placerat neque non leo. Fusce massa.
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Duis sit amet dui id diam venenatis vulputate. Praesent malesuada turpis a velit.
Donec leo sem, auctor vitae, dictum sed, vulputate et, libero. Phasellus a risus. Proin ut
ante in felis imperdiet molestie. Pellentesque consequat ultricies felis. Nulla scelerisque
condimentum sapien. Phasellus iaculis luctus mi. Suspendisse facilisis. Suspendisse in
libero. In auctor nunc quis tortor. Nam suscipit nulla et lorem. Ut purus ligula, vehicula
eget, malesuada ac, vestibulum eu, enim.

. Donec consequat justo a orci commodo pharetra.

. Vestibulum ante ipsum primis in faucibus orci luctus et ultrices posuere cubilia
Curae; Nullam condimentum arcu in turpis.

o Nam justo sem, congue ut, egestas nec, tempor sed, turpis. Proin justo arcu,

hendrerit posuere, auctor eget, pharetra a, tellus. Nulla sagittis. Nulla quis mi at
turpis ultricies adipiscing. Quisque venenatis. Sed ut libero.

Etiam lectus orci, luctus ut, tempor non, adipiscing a, libero. Fusce turpis ipsum,
ultricies nec, varius ac, pretium vel, pede. Sed turpis massa, aliquet nec, adipiscing sed,
viverra eu, arcu. Pellentesque commodo iaculis leo. Vivamus nunc nibh, tempus sit
amet, molestie vitae, euismod quis, lacus. Phasellus vitae justo ac nulla vestibulum

rhoncus.
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LIST OF REFERENCES

The candidate should use the style of one scholarly journal in his or her discipline.
The Graduate School checks all manuscripts for correct and consistent usage within the
chosen style. Failure to document references in a consistent and acceptable style

necessitates that the manuscript be returned without review.
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BIOGRAPHICAL SKETCH

A biographical sketch is required of all candidates. The biographical sketch should
be in narrative form. It typically includes the educational background of the candidate.

You may replace this paragraph with your own text.
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